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Documentation Updates
The title page of this document contains the following identifying information:
•

Software Version number, which indicates the software version.

•

Document Release Date, which changes each time the document is updated.

•

Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document,
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You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

Support
Visit the HP Software Support web site at:
http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support
that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:
•

Search for knowledge documents of interest

•

Submit and track support cases and enhancement requests

•

Download software patches

•

Manage support contracts

•

Look up HP support contacts

•

Review information about available services

•

Enter into discussions with other software customers

•

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
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Operations Log Intelligence (OLI) 1.0.0
These release notes provide information about the OLI 1.0.0 release. Read this
document in its entirety before using OLI.
This document covers the following topics:

Confidential



“Supported Platforms” on page 8



“Supported Browsers” on page 9



“Localization Information” on page 10



“OLI Documentation” on page 11



“Known Issue” on page 12



“Open Issues” on page 13
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Supported Platforms

Supported Platforms
You can install OLIs on platforms with the hardware specifications and supported
operating systems outlined below, according to the indicated deployment
scenarios.
This information applies to both physical and virtual machines.
The sum of memory configurations of the active VMs on a VM server
must not exceed the total physical memory on the server.

Specification

Details

Supported
Operating Systems

•

Red Hat Enterprise Linux (RHEL) versions 6.2 and 5.5, 64-bit

•

Oracle Enterprise Linux (OEL) version 5.5, 64-bit

•

CentOS version 6.2, 64-bit

•

CPU: 2 x Intel Xeon Quad Core or equivalent

•

Memory: 12 - 24 GB (24 GB is recommended)

•

Disk Space: 65 GB (minimum)

CPU, Memory, and
Disk Space

NOTES:

Other Applications
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•

The disk space needs to be on the partition where you will
install the OLI software.

•

Using NFS as primary storage for events on the software OLI is
not recommended.

For optimal performance, make sure no other applications are
running on the system on which you install OLI.

HP Operations Log Intelligence 1.0.0 Release Notes

Confidential

Supported Browsers

Supported Browsers
These browsers are supported for accessing OLI 1.0.0:


Firefox: ESR 24



Internet Explorer: Versions 8 and 9
For Internet Explorer browsers, make sure that:
•

You turn on Compatibility View if you use IE 9 to ensure that the OLI
user interface displays correctly.

•

The SSLv3 or TLSv1 option is enabled to access the software OLI
user interface. If none of these options is enabled, you will not be
able to connect to the software OLI.
To access the SSLv3 and TLSv1 settings, in your IE browser, click
Tools > Internet Options > Advanced > Scroll down to locate SSL
3.0 and TLS 1.0 under the Security section.

An Adobe Flash Player plug-in is required on these browsers for some of the
features, such as Histogram and charts, to work.
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Localization Information

Localization Information
Localization support for these languages is available for OLI:


Japanese



Traditional Chinese



Simplified Chinese

You can install OLI in one of the above languages.
You can change the locale when installing OLI. Once set, the locale cannot be
changed. If the locale is not set, a banner message on your OLI UI is displayed. If
you have not yet configured the locale, you can do so from the Locale page under
the System Admin tab.

Known Limitations
The following are the currently known limitations in the localized versions of OLI:
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Some OLI user interface sections are not localized. For example, the
following sections are available in English only:


Reboot



Network



License & Update



CIFS



NFS



RAID controller



SSL Server Certificate



Authentication



Summary



Dashboards



Field Summary, on the Search Results page



Only ASCII characters are acceptable for full-text search and the Regex
Helper tool.



An OLI user cannot have a login name that contains native characters. That
is, the login field on the Add User page does not accept native characters.
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OLI Documentation

OLI Documentation
The following documentation is available for this release:
OLI Administrator’s Guide — Available from your installation package or for
download from the SSO site: http://support.openview.hp.com/selfsolve/manuals.
This information is also accessible from the integrated online Help.
OLI Online Help — Integrated in the OLI product and accessible through the user
interface. Click Help on any OLI user interface page to access context-sensitive
Help for that page. This information is also accessible from the OLI
Administrator's Guide.
To check for recent updates, or to verify that you are using the most recent version
of a document, go to:
http://h20230.www2.hp.com/selfsolve/manuals
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Known Issue

Known Issue
There is a known issue with the Global Summary Persistence functionality in OLI
1.0.0. This feature is designed to persist the statistics reported in the global
summary section of OLI through a reboot. In some environments, disk space or
server memory may be affected due to this feature.
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Open Issues

Open Issues
OLI 1.0.0 includes the open issues listed in the following tables. Use the noted
workaround where one is available.

Analyze/Search
Issue

Description

LOG-11299

If you uncheck the Rerun query option when exporting search results of a
search performed on peer OLIs, the export operation might fail.
Workaround: The Rerun query option is checked by default. Do not
uncheck it when exporting results of a search performed on peer OLIs.

LOG-11294

When a user defined rex field name contains a space, an error message
shows up and the field summary is not displayed.
Understanding: The rex operator does not support spaces in user defined
field names.
Workaround: None at this time.

LOG-11225

When using the Auto Complete feature on the Search page, if the query
has a double quote followed by bracket (i.e. "[), then the query inserted by
the Auto Complete cannot be executed because of incorrectly escaped
quotes and backslashes.
Workaround: Remove the backslash followed by a double quote on both
sides of the string. For example, if the query inserted by the Auto Complete
is "\"[/opt/mnt/soft/OLI_server.log.6] successfully.\"", then after removing
them, the query becomes "[/opt/mnt/soft/OLI_server.log.6] successfully."
This workaround can be also used for the double quote followed by any
special character such as "\ "/ "[ "] ",

LOG-10130

The Fields command leaves the field name even though all the values from
that field are removed. Therefore, an empty column appears in the search
results with the <fieldname> as the title.
Workaround: Make sure you use the CEF operator to define the field
before using the FIELDS operator. Doing so ensures that the field and its
associated values are removed.

LOG-10126

When using the replace operator, if the "from" string is included in the
replacement string, the "from" string will be replaced twice. For example,
the following command, when run against the data "john smith" will result in
"johnnyny smith":
| replace "*john*" with "*johnny"
Workaround: None available at this time.

LOG-9420

When using the search term "transaction" on data that was received out of
order, the duration may appear to be negative.
Workaround: Include the term "sort _eventTime" before the transaction
term.
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Open Issues

Issue

Description

LOG-8760

Currently, only one search operation per browser can be run on OLI at any
time.
Workaround: For Firefox, use the add-on called Multifox, available at
https://addons.mozilla.org/en-US/firefox/addon/multifox/. For Internet
Explorer, create multiple DNS entries in the hosts file for the same IP
address so that you can run different sessions at the same time.

LOG-8751

When search results are exported, the "Fields" field may be empty.
Workaround: Although this situation does not occur consistently, if it does
occur, ensure that All Fields is selected in the "Fields" field set on the
Search Results page. Then, click Export Results.

LOG-8484

The stdev function in the chart operator does not work when operating on
data that has more than 10 digits. The result of this computation will display
a blank field.
Workaround: None at this time.

LOG-8076

The Regex Helper tool does not support native characters, such as
Traditional Chinese characters.
Workaround: None at this time.

LOG-7864

The time in several fields is not in human readable format when exported.
These fields include deviceReceiptTime, startTime, endTime, and
agentReceiptTime.
Understanding: OLI records time field values in UNIX epoch format (long
values).
Workaround: Use an epoch formula in Excel to convert the time value from
epoch time.

LOG-7758

When the eval operator is used after the chart operator, the chart results do
not match the results in the table (i.e. No bar will be shown for the column
added by the eval).
Workaround: Since the eval used after the chart operator creates this
issue, use the eval before the chart operator if possible.

LOG-7651

On the Internet Explorer browser, data is truncated in the Advanced Search
calendar popup window. This issue affects users' ability to select a date
using the date picker (icon) when setting CCE rules in the Advanced
Search feature. When a user clicks the date picker, the calendar widget
that comes up is not wide enough to display the full calendar content,
truncating columns with the latter days of the week. This issue does not
happen on Firefox. When a user navigates along the top menu: Analyze >
Search, the hyperlink labeled "Advanced Search" brings up the CCE.
Entering a rule based on a field that represents a date presents the date
picker in the Condition field.
Workaround: Use the Tab key to scan along the part of the calendar that is
initially hidden, then use Shift+Tab to scan back in the other direction.
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Open Issues

Issue

Description

LOG-7099

When values for user fields such as sourceUserId, sourceUserName,
destinationUserId, and cs1 contain "\n" character, the search results are
not displayed correctly.
Understanding: The current software interprets a value that contains "\n" as
a newline character. For example, user name "nancy" in example domain,
"example\nancy", is interpreted as "example[newline]ancy".
Workaround: Disable the multi-line feature by adding the following
properties to /user/logger/logger.properties. The following examples use
the default values.
- To on/off the multiline support
search.multiline.fields.supported=true
- To on/off the \\n and \\t support
search.double.backslash.newlines.supported=false
- To on/off the DOS/Windows path support for CEF and/or syslog
search.keep.windows.path.cef=true
search.keep.windows.path.syslog=true

LOG-7046

On a software OLI, the time displayed on the histogram might not match
the event time. This behavior is observed when the /etc/localtime file is not
symbolically linked to the correct timezone.
Workaround: Make sure that the /etc/localtime file is symbolically linked to
the correct timezone in the /usr/share/zoneinfo file as shown in the
following example. Then, restart the system on which software OLI is
installed.
sudo ln -s /usr/share/zoneinfo/<timezone>
/etc/localtime

LOG-6965

When the time change due to Daylight Savings Time (DST) takes place,
the following issues are observed on OLI:
- The 1 a.m. to 2 a.m. time period is represented in DST as well as
standard time on the histogram.
- The histogram displays no events from 1 a.m. to 2 a.m. DST even though
the OLI received events during that time period.
- The events received during 1 a.m. to 2 a.m. DST are displayed under the
1 a.m. to 2 a.m. standard time bucket, thus doubling the number of events
in the histogram bucket that follows an empty bucket.
- Because the 1 a.m. to 2 a.m. time period is represented in DST as well as
standard time on the histogram, the bucket labels might seem out of order.
That is, 1:59:00 a.m. in DST may be followed by 1:00:00 in standard time
on the histogram.
- If the end time for a search falls between 1 a.m. and 2 a.m., all of the
stored events might not be returned in the search results.
Workaround: To ensure that all events are returned, specify an end time of
2:00:01 or later.
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Open Issues

Issue

Description

LOG-6273

When search results are exported, the time elapsed to export the events is
not displayed.

TTP#69023

Workaround: For the search elapsed time, please refer to the elapsed time
shown in the stats on the search page.
LOG-6199
TTP#68780

When the time change due to Daylight Savings Time (DST) takes place,
the following issues are observed on OLI:
- The 1 a.m. to 2 a.m. time period is represented in DST as well as
standard time on the histogram.
- The histogram displays no events from 1 a.m. to 2 a.m. DST even though
the OLI received events during that time period.
- The events received during 1 a.m. to 2 a.m. DST are displayed under the
1 a.m. to 2 a.m. standard time bucket, thus doubling the number of events
in the histogram bucket that follows an empty bucket.
- Because the 1 a.m. to 2 a.m. time period is represented in DST as well as
standard time on the histogram, the bucket labels might seem out of order.
That is, 1:59:00 a.m. in DST may be followed by 1:00:00 in standard time
on the histogram.
- If the end time for a search falls between 1 a.m. and 2 a.m., all of the
stored events might not be returned in the search results.
Workaround: To ensure that all events are returned, specify an end time of
2:00:01 or later.

LOG-5958
TTP#67643

When a field is removed from the Selected Fields list in the Customize
FieldSet Editor, the field might not be displayed in the available fields list.
Workaround: This only happens if you use the <- arrow to remove the field.
If you double click on it, it will go back to the correct list.

LOG-5181
TTP#63055

Search results are not highlighted for values that match the IN operator in a
query.
Workaround: None at this time. Highlighting works if there's only 1 item in
the square brackets. As soon as there's more than 1, no highlighting
occurs.

LOG-4888
TTP#61139

When the Color Block View in the Search Builder tool (accessed using the
Advanced Search link on the main Search page) is used to build a query
with only one condition, the following warning is displayed: "Failed to
construct a legal query, please check your query elements and try again!"
Additionally, once this warning is displayed, you cannot switch to Tree View
to build a single condition query.
Workaround: Right-click and delete the starting "AND" condition that OLI
enters. Then, enter the condition into the grid. Alternatively, you can also
right-click on the "undefined" node that remains after you delete "AND",
then select the option to add a new condition.
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Issue

Description

LOG-4775

The user interface for the Advanced Search link (on the Search page) to
create a query is not intuitive about how to enter a keyword (fulltext) term.

TTP#60716

Understanding: To specify a keyword (full-text search), use the fullText field
under the Name column. This field is displayed at the bottom of the pane.
Workaround: If you do not see the full-text search field, scroll down.
LOG-4329
TTP#59612

The full-text (keyword) search cannot find events that contain an IP or a
MAC address that is prefixed with an equal to (=) character in the actual
event. For example, these full-text queries will not locate the following
event.
Query 1: "ff:ff:ff:ff:ff:ff:00:02:2d:0c:6f:d4:08:00"
Query 2: "192.168.10.153"
Query 3: "192.168.10.255"
<166>Sep 9 14:48:22 beach kernel: Killed bad
incoming packet: IN=eth1 OUT=
MAC=ff:ff:ff:ff:ff:ff:00:02:2d:0c:6f:d4:08:00
SRC=192.168.10.153 DST=192.168.10.255 LEN=229
Workaround: This problem only occurs for a very small number of devices,
which use this particular format. The workaround is to search for the
term/word that precedes the equal to (=) character in the event followed by
the IP address or MAC address For example: search for
"SRC=192.168.10.153" when looking for 192.168.10.153 and
"DST=192.168.10.255" when looking for 192.168.10.255. Alternatively, you
could run these data through a SmartConnector to convert to CEF format.
Then run either a full text or field based search.

LOG-2325

The hits count on the Alerts page (Analyze > Alerts) is not accurate.

TTP#48498

Workaround: None at this time. Currently, there is no way to know the
correct hits count on the Alert page.

LOG-1384

The Save to OLI operation overwrites an existing file of the same name.

TTP#42662

Workaround: Use unique file names when using the Save to OLI operation.

Configuration
Issue

Description

LOG-11263

When new custom fields are added in the maintenance mode, no
maintenance results for them will be added.
Workaround: There is no workaround for this issue.

LOG-11261

When new custom fields are added in the maintenance mode, no audit
event will be recorded.
Workaround: There is no workaround for this issue.
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Issue

Description

LOG-11176

When you enable a receiver, OLI does not validate the RFS mount it
referenced.
Workaround: Make sure the RFS mount is valid by clicking edit button for
this receiver. Alternatively, check the Admin page.

LOG-10605

The Source Types tab (Configuration > Event Input > Source Types) is not
visible for non-admin users.
Workaround: Add 'Read Only Default Admin Group' privileges to the user.

LOG-10581

When a parser associated with a Source Type and Folder Follower
Receiver is deleted, no warning message is displayed indicating the
dependency.
Workaround: None at this time.

LOG-10353

High incoming event rates can have an effect on the indexing rate of the
OLI.
Workaround: If you notice that indexing is falling behind, decrease the
incoming event rates.

LOG-10058

Sending events targeted to an IPv6 address on OLI is not supported. The
system state is unknown once it happens.
Workaround: Restart the "receiver" process.

LOG-10056

You may get a duplicate device name if a receiver was removed and a new
one was created with the same name as old one. When you search on this
device, OLI uses the old device and you will not be able to search on the
new device.
Workaround: To avoid this problem, do not create receivers with same
names as any deleted receivers.

LOG-9658

If you have already increased your storage volume to the maximum limit
allowed by your license, and you attempt to increase the volume further,
the error message displayed is incorrect. Instead of notifying you that you
have reached the limit of your license the message says: "Sufficient free
space is not available to increase the storage volume size. To restore
normal OLI operation, click Restart".
Workaround: Click Restart. No further action is required. However, if you
need to increase the storage limit, please contact HP Support.

LOG-9498

OLI only parses syslog headers that are in the format specified by
RFC3164 (traditional syslog headers). Newer syslog header formats
specified by RFC3339 (syslog-ng headers) are not supported.
Workaround: None at this time.
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Issue

Description

LOG-9305

Connectors send values of date/time-type fields in the following format:
07/09/0169 09:57:35.000 PST
Understanding: This is a format that OLI does not understand. It expects
time field values to be in epoch format (long values).
Workaround: Convert the time value into epoch time for OLI to be able to
process them correctly.

LOG-8801

Sometimes after changing the Event Archive mount locations, manually
created archives may show an "Invalid Mount" message.
Workaround: Refresh the page to clear this message.

LOG-8790

When the community string contains non-ASCII characters, the SNMP trap
sent out has "??" in the community field.
Understanding: This is a UI issue and does not affect SNMP authentication
on OLI.
Workaround: Avoid using non-ASCII characters in the community string.

LOG-8194

After restoring OLI from backup configuration, the CIFS share failed to
mount because the user name and password fields were empty.
Workaround: Edit the setting of the CIFS share and re-enter the username
and password.

LOG-7445

If the Archive Settings are changed from one mount point to another, the
archives created after the mount point was changed may not display. In
that case, the following error message is displayed: "Could not find an
archive."
Workaround: Use Ctrl-F5 to perform a hard refresh of your browser
window.

LOG-6786

Events may be missed when a receiver on OLI is disabled.
Workaround: None at this time.

LOG-6209
TTP#68824

If the Finished Tasks page (Configuration > Scheduled Tasks > Finished
Tasks) contains a very large number of entries, the page sometimes takes
a while to load or stops loading.
Workaround: If the pages stops loading, refresh the browser window to
continue loading.

LOG-5024
TTP#61517

If the system that OLI backs up its configuration to is reinstalled or its SSL
key is changed, the configuration backup fails because the SSL key cannot
be refreshed from the OLI UI.
Workaround: Log in to the Command Line Interface and delete the entry in
the /home/arcsight/.ssh/known_hosts file. Then refresh the config backup
configuration.
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Issue

Description

LOG-4986

If there is an improper tear-down of the peering relationship, OLIs in the
relationship might not detect it. Consequently, when you try to reestablish
the relationship, it might not succeed.

TTP#61369

Examples of improper tear-down: The peering relationship is deleted on
one OLI while the other is unavailable (power down).
Workaround: If there is an improper tear-down of a peering relationship
and you need to reestablish it, delete the existing peer information from the
peer OLIs before re-initiating the relationship.
LOG-4885
TTP#61134

After a certificate is deleted from these pages, the deleted certificate is still
displayed in the list, leading to an impression that the certificate is still
loaded on the system:
Configuration > Event Input/Output > Certificates
Configuration > Alerts > Certificates
Workaround: Refresh the page to update the list. The deleted certificate is
no longer displayed in the list.

LOG-4595
TTP#60152

Even if pre-allocation of storage fails before the minimum requirement has
been met, OLI allows you to skip preallocation and proceed to storage
configuration.
Workaround: If pre-allocation fails, try to resume it. Skipping pre-allocation
before it has successfully completed may result in sub-optimal
performance on OLI.

LOG-3944
TTP#57778

A configuration backup is not successful if the Remote Directory name
contains a space.
Workaround: Ensure that the Remote Directory name does not contain a
space.

LOG-3156
TTP#52201

If content is imported on an OLI that does not have the same configuration
setup (devices, device groups, storage groups) as the exporting OLI,
content that relies on that configuration cannot be used.
Workaround: None at this time. The feature assumes that importing OLI
has the same configuration setup as the exporting OLI.

LOG-2941
TTP#51630

The type associated with imported filters cannot be changed from shared
to saved search.
Workaround: Imported filter types cannot be changed. However, you can
copy the filter definition and create a new filter out of it.

LOG-2387
TTP#48816

The EPS Out gauge reports a non-zero value even when no Forwarders
are enabled.
Understanding: This gauge reports traffic from real-time alerts as well as
from Forwarders. Therefore, if you have Alerts configured on your OLI,
EPS Out can be greater than zero.
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Issue

Description

LOG-2244

A forwarder configured with a filter might not forward events that match the
specified end time.

TTP#47758

Workaround: Extend the end time by 1 second to ensure that all events are
forwarded appropriately.
LOG-370
TTP#36373

The Configuration Backup (Configuration > Configuration Backup >
Name_of_Backup) and File Transfer Receivers (Configuration > Event
Input/Output > Receivers) fail silently. The most likely cause is a problem
with configuration parameters such as Remote Directory, User, or
Password. If an error occurs, the command appears to succeed but it does
not.
Workaround: The error is written to the log in this case, so use Retrieve
Logs page (Configuration > Retrieve Logs) if you suspect a problem with
the backup. When Configuration Backup is scheduled, error status is
shown in the Finished Tasks status field.

Dashboards
Issue

Description

LOG-11730

When there are two or more same name dashboards, after you select one
of them from the dashboard dropdown, there is no way to show the other
dashboards with the same name from the dropdown. This is because when
selecting one of same name dashboards, the dropdown internally thinks
the first entry of those dashboards is selected always.
Workaround: Rename the same name dashboards to different names.

LOG-11223

If the index is slightly behind, drilling down on the receiver may return no
results.
Workaround: Change the end time of the query to be slightly earlier
(usually only a couple minutes) to obtain the results.

LOG-9332

When the monitor graph panel is not wide enough to show the entire graph
in the monitor or custom dashboards, the graph will be cut off and no scroll
bar is shown in the panel, in the Firefox browser. For the Internet Explorer 9
browser, the panel is blank.
Workaround: For the custom dashboards, make the browser window wider
or change the layout of the panels so that each graph panel will have
enough width to show the graph (i.e.: If the row including a monitor graph
panel has 3 panels, move at least one of the other panels to the other row).
For the monitor dashboard, make the browser window wider.
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General
Issue

Description

LOG-11659

In software OLIs, the installation of multiple Solution Packages may fail if
the SOX v4.0 solution package is installed in the wrong order by the root
user.
Workaround: If you are installing the SOX v4.0 solution package as the root
user, install it last.

LOG-2433
TTP#49017

If you click on another tab or page before a UI page is fully loaded, the UI
attempts to load the latter page, but eventually displays the former page.
Workaround: Wait for the current page to finish loading before clicking
another one.

Summary
Issue

Description

LOG-11698

On OLI’s Summary page and custom OLI dashboards, the user's session
will not time out. This is because any panel that updates the contents
automatically extends the user's session. However, since the Search
Results panels do not refresh automatically after completing the search, if a
custom dashboard has only the Search Results panels, then the user's
session will be able to time out after completing all the searches in the
dashboard.
Workaround: Since the Summary and Dashboards pages auto-update the
contents automatically, to take advantage of the auto-timeout feature, the
user needs to move to a page, such as the Search page, that does not
auto-refresh.

LOG-10084

The Count value displayed on the Summary page may be slightly different
from the Hit value on the Search page for the same field.
Understanding: The difference occurs due to multiple reasons such as the
delay between when the Count was displayed on the Summary page and
when the search query was run on the Search page. Additionally, indexing
may lag behind when there are large number of incoming events, thus
causing a discrepancy between the Count on the Summary page and Hit
value on the Search page.
Workaround: None at this time.
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Issue

Description

LOG-9955

On the Summary page or in any of the Summary panels included in a
custom dashboard, if the number of events in the Count column is very
large (in the range of 1 million or higher) and you drill down to view those
events, your system may experience performance issues.
Workaround: If you need to drill down to view a large set of events (in the
range of 1 million or higher), HP highly recommends that you follow these
steps to prevent the performance impact very large search results sets can
have your system:
1. Cancel the search that automatically starts once you click on a resource
(receiver, device, agent severity, or agent type).
2. Change the Start and End time values for the search query such that
they span a smaller time range. By default, these values are set to the last
time your OLI was rebooted/restarted and the current time, respectively.
3. Run the search with the new Start and End time values.

LOG-9829

When you drill-down from the Summary page, the time range that the
search query runs with is not exactly the same as the one shown on the
page from where you drill down.
Understanding: The granularity of time used for the Summary page is
different from the Search page; therefore, the numbers are different.
Workaround: None at this time. Currently, there is no way to specify the
search time range in milliseconds.

LOG-9772

The number of events indexed as shown on the Summary page may not
match the number of events found when you run a search with the same
time range as shown on the Summary page.
Understanding: The granularity of time used for the Summary page is
different from the Search page. Therefore, the numbers are different.
Workaround: None at this time. Currently, there is no way to specify the
search time range in milliseconds.

System Admin
Issue

Description

LOG-11712

If the Certificate Alias has spaces in it (i.e. test certificate), the certificate
will not be removed from the list even after deleting the certificate.
Workaround: Instead of spaces, use underscores in the Certificate Alias so
that the certificate can be removed properly.

LOG-11700

Users may be unable to log in after they have been removed from a group.
Understanding: Removing all group assignments from a user effectively
disables that user account. User accounts not assigned to any group will
be unable to log in.
Workaround: To avoid disabling a user account when removing the user
from a group, check that the user is assigned to the correct groups.
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Issue
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LOG-11205

Some System Administration pages do not render correctly when using
Microsoft Internet Explorer-9.
Workaround: To use this version of the browser, ensure that Compatibility
Mode is set On. This can be found under Tools > F12 Developer Tools >
Browser Mode.

LOG-11066

If the system time zone is set to /US/Pacific-New, then the software OLI will
have the following issues:
1. On the Search page, the Events grid in the search results will be empty
for any search,
2. The timestamps with timezone will be shown using GMT,
3. In the Global Summary on the Summary page, the Indexing is reported
one hour behind the current time stamp.
Workaround: Change the system time zone to something to more specific,
such as /America/Los_Angeles.

LOG-9288

The System Admin - FIPS 140-2 page can take several seconds to load.
Workaround: None at this time.

LOG-1050
TTP#40872

Under certain circumstances, users with restricted privileges might still see
Device Group and Storage Group names. If these users are also subject to
a Search Group Filter (enforced filter), they will not be able to see events in
those Device Groups or Storage Groups.
Workaround: Provide Device Group and Storage Group names that do not
reveal internal information.
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